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Introduction

Welcome to the user manual for UpStage version 3; released in January 2014, this version incorporates
audio-visual streaming, introduces many new features and provides significant enhancements to the
workshop and media management system.

If you are working with an earlier version of UpStage, please refer to either the version 2.4.2 manual or
the version 2.1 manual.

Background

UpStage is a web-based venue for cyberformance' - the real-time compilation of digital media into live
performance, by multiple remote players for an online audience (and sometimes an offline audience as
well). People anywhere in the world can participate in live performance events by using standard browser
software to access UpStage, without having to download and install additional software and without
needing to know anything other than a web address.

The concept for UpStage was developed by Avatar Body Collision, a globally dispersed cyberformance
troupe whose members have been experimenting with online theatrical performance since 1999, and
together as Avatar BodyCollision since 2002. UpStage was born from the desire to reach a wider audience
and to make it easier for audiences and performers alike to participate in live performance via the internet.

The software combines the different elements of cyberformance - graphical avatars, web cams, audio,
images, text chat (and who knows what else in the future) - into a single interface. The audience simply
directs their browser to the web address at the appointed time, to watch and participate in the
cyberformance.

The UpStage server application is open source and free to download. It is available under dual licensing:
a Creative Commons Attribution-NonCommercial-ShareAlike 3 License and GNU General Public
Licence (GPL).

The initial development of UpStage was funded in 2003 through the Smash Palace Collaboration Fund, a
joint initiative of Creative New Zealand and the NZ Ministry of Science, Research and Technology. In
2006, the UpStage project received funding from the Community Partnerships Fund of the New Zealand
government’s Digital Strategy to develop UpStage version 2. UpStage V2 was also supported by partners
CityLink, MediaLab and Auckland University of Technology.

Currently, UpStage is supported byCityLink,who provide free server hosting and traffic, and Auckland
University of Technology,who provide teams of final-year computer programming students to work on
the ongoing development of the software. The UpStage team and user community are very grateful for
this vital support.

Open sessions are held regularly in UpStage, providing training in the basic use of UpStage and how to
create cyberformance; everyone is welcome. For dates and times for the next open session, visit
www.upstage.org.nz and join the UpStage Announce list.

If you are looking for technical support including instructions for installing the UpStage server, please
visit the Developers page on the UpStage web site, and join the developers' mailing list.

For further information and updates, please visit www.upstage.org.nz.

1 Cyberformance uses internet technologies to bring remote performers together in live theatrical
events; Www.cyberformance.orgA


http://en.flossmanuals.net/upstage-v242-user-manual/
http://www.avatarbodycollision.org/
http://creative-catalyst.com/cyberformance/
http://www.upstage.org.nz/
https://sourceforge.net/mailarchive/forum.php?forum_name=upstage-list
http://upstage.org.nz/blog/?page_id=1553
https://lists.sourceforge.net/lists/listinfo/upstage-announce
http://www.upstage.org.nz/
http://www.aut.ac.nz/
http://www.aut.ac.nz/
http://www.citylink.co.nz/
https://github.com/AUTUpStageTeam/UpStage2013
http://www.upstage.org.nz/
http://en.flossmanuals.net/upstage-user-manual/

UpStage Team

UpStage was initiated in 2003 by Avatar Body Collision, who are Vicki Smith, Leena Saarinen, Karla
Ptacek and Helen Varley Jamieson. The project continues to be managed by Vicki Smith and Helen Varley
Jamieson. For more information about the Colliders, please visit www.avatarbodycollision.org.

The UpStage application was originally written by Douglas Bagnall, who is a digital artist with a
background in open source development of online projects. His artistic work includes the development of
a film-making robot and a cloud-classifier; visit http://halo.gen.nz/for more information.

At the end of 2010, former AUT student Paul Rohrlach joined the team as a developer and server
administrator and in 2011 Francesco Buonaiuto became our volunteer documentor. Many other artists are
involved in the annual UpStage Festival, and we have a growing team of open source developers who are
supporting the maintenance and development of the software.

Since December 2004, the UpStage server has been generously hosted by Citylink.

Thanks to Anne Philpott, we have an ongoing relationship with Auckland University of Technology (New
Zealand) since 2006, in which teams of students in their final year of Bachelor of Computer and
Information Science work on UpStage as their major assessment project.

The AUT UpStage teams to date are:

* 2013-14: Vanessa Henderson and Nikos Philips

e 2013: Lisa Helm, David Daniels and Nitkalya Wiriyanuparb

e 2012-13: Scott Riddell, Gavin Chan &Craig Farrell

* 2012: Benjamin Qin and Daniel Han

e 2011-12: Nessa Baterina, Karena Goh, Corey Robb

* 2011: Heath Behrens and Vibhu Patel

e 2010-11: Mohammad Al-Timimi, JR Malonzo and Henry Goh

* 2010: Tom Choi, Paul Rohrlach & Craig Farrell

* 2009-10: Natasha Pullenster, Nicholas Robinson and Shaun Narayan
* 2009: John Coleman and Vishaal Solanki

* 2008-09: Shaun Nesbitt, Wendy Wen, Candy Yang

* 2008: Aaron Barnett

* 2007-08: Alan Crow and Tony Wong

e 2007: Endre Bernhardt, Lauren Kilduff & Phillip Quinlan

e 2006-07: Beau Hardy, Francis Palma, Lucy Chu and Wise Wang.

Many other people have contributed to the development of UpStage through encouragement, advice, user
testing, feedback, and simply believing that it was possible. The project team thanks every one of you.

If you are interested in being a part of the development of UpStage, you can join the developer list,
https://lists.sourceforge.net/lists/listinfo/upstage-list.

If you would like to be kept informed about events in UpStage, you can join the announcements list:
https:/lists.sourceforge.net/lists/listinfo/upstage-announce.

The UpStage User Manual has been compiled by David Daniels, Nikos Phillips and Helen Varley
Jamieson, and is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 3.0
Unported License.
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Technical Information

UpStage is a server-side application. This means that it runs on a web-server, and the users of UpStage
(players and audience) access it via a web browser; you do NOT install UpStage on your own computer.

If you have access to a web server and wish to install your own, customisable, version of UpStage, please
refer to the installation manual and other support available on the Git Hub site.

Programming technologies

UpStage is written in Python, using theTwisted framework for event-driven asynchronous networking. It
doesn't require Apache (or MYSQL or anything else). The client is written in pure Actionscript, and is
compiled using Mtasc, so there is no requirement for Macromedia software other than the Flash player
plug-in on the client computer.

Words typed in by the players are converted into speech using the Fesitval speech library, eSpeak and
MBROLA, and streamed to the clients as MP3s.

The server runs on Debian Linux, but should easily convert to other platforms. Python and Twisted are
cross-platform, but there is a line or two of shell scripts that tie in the speech synthesis.

The software has been worked on since June 2003 and contains some 8000 lines. Please visit our Git Hub
site to find the latest stable version and installation documentation.

Client hardware and software requirements

If your computer has a browser with the Flash player plug-in and an internet connection, then you already
have everything you need to use UpStage. Obviously faster processors and higher RAM give improved
performance, but UpStage has been designed to work on relatively low-spec client machines.

A broadband internet connection will give the best performance, but UpStage performs surprisingly well
over dial-up. The main disadvantage when using dial-up is that the load time for each stage is longer. You
may need to allow up to 15 minutes to load a stage, depending on how many graphics are on it. Once it’s
loaded, the real-time interaction and overall performance of UpStage is not much slower on dial-up than
on broadband.

UpStage has been designed to run on a wide range of clients using the Macromedia Flash Player plug-in
(we recommend the latest version). It should function properly in all standard browsers such as Firefox,
Safari, Internet Explorer and Opera.

Linux users may need to install gsfonts and gsfonts-x11 (see the section Troubleshooting for information
about this).

Note: due to an issue in Internet Explorer 7 and below, you will not be able to use the media edit or media
upload pages. For this reason we recommend the use of either alternative browser (such as Firefox or
Chrome) or update to Internet Explorer 8 or above.

Firewalls
CHECK THIS SECTION - DOES IT NEED UPDATING? PORT(S) FOR STREAMS? <you will need to

check this one with Martin> with Paul for our UpStage server; also need to check re streaming ports
required.


https://github.com/AUTUpStageTeam/UpStage2013/releases
https://github.com/AUTUpStageTeam/UpStage2013/releases
http://tcts.fpms.ac.be/synthesis/mbrola.html
http://espeak.sourceforge.net/
http://festvox.org/festival/
http://www.mtasc.org/
http://twistedmatrix.com/
https://github.com/AUTUpStageTeam/upstage2013/wiki/Server-Manual

UpStage will function through most but not all firewalls, depending on how the firewall has been set up.

If you install your own UpStage server, it will ask you to specify which ports you want to use (the
defaults are 8081 and 7230). You will need to ensure that your users have the correct ports open.

The Open UpStage server uses ports 8084 and 7230-7233, therefore these ports need to be open if you are
trying to access this server through a firewall. These ports are open by default in most private internet
connections, but some organisational networks will close any “unnecessary” ports.


http://upstage.org.nz:8084/

Audience View

Audience members enter UpStage by following a web link from an email or web page; you do not need to
download or install any additional software as long as you have a browser with the Flash player plug-in.?
Audience members do not log in, and do not have access to the on-stage tools used by the players.

Once the stage loaded in the browser window, you will see and hear the performance and be able to
participate in the text chat by typing into the text input field. Audience chat is silent, whereas avatars

operated by players have audible synthethised voices.

An example of the audience view of the stage is shown below: the text chat window is at the right, with
an input field at the bottom and up-down scroll arrows on the right top and bottom corners. Above the text
chat window, a counter shows how many players and audience members are on the stage. The rest of the

screen is the "stage" where the visual action of the performance takes place.
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Screengrab from the 101010 UpStage Festival foyer, showing festival curators
Dan Untitled, Vicki Smith and Helen Varley Jamieson MCing between shows.

2 The Flash player plugin comes preinstalled with most browsers; if you don't have it, it is free to

download here: www.adobe.com/support/flashplayer/downloads.html.



http://www.adobe.com/support/flashplayer/downloads.html

Audience Chat

Audience members are also known as "chatters", because they can interact with the performance by
typing into the text input field at the bottom right of the screen. This text appears in the text chat window,
amongst the players’ text.

Audience text is grey, silent and anonymous, while players' text is black, slightly larger than audience
text, spoken aloud by the computer and identified with the avatar’s name. Audience can identify
themselves by manually adding a name at the start of their comments; in the future it will be possible for
audience members to have a name if they want.

This screengrab, from West Side's Story T — 1
(101010 UpStage Festival), shows e : !
audience and player text in the chat. |

The audience chat has a life of its own.
Often at the beginning of a performance,
audience members will ask where other
people are physically located and have
conversations between each other.
During the performance, the audience
can respond to and comment on the
action of the performance, embellish the
narrative or provide a counterpoint.
Obviously every audience is different,
making every performance significantly
different - sometimes an audience may

hello mrs baker

be very quiet and at other times they can
be very chatty.

Re-presenting the chat

Audience text can also be incorporated into the performance, for example repeated or responded to by the
players. Another effective re-presentation of audience chat into the performance is the projection of chat
text and its subsequent capturing and re-presentation as a streamed image, as shown in the screengrab
below from Belonging by Avatar Body Collision (2007).

Y Bcrgrg

Form one line please.
Single file. Stand clear.
Mind the yellow line.
No drugs, weapons or
vegetables are
allowed. Have your
passports open at the
photo page. Madame.

Passport,

\\ <t



http://upstage.org.nz/blog/?page_id=680

Audience Interactivity

The primary form of interactivity for the audience is the text chat, discussed in the previous chapter.
There are also a few other things that the audience can do.

Commands

Audience members can use a number of commands in the text chat; these are instructions typed into the
text chat input field after a /

For example:

» /asize 8 (or another number): this changes the font size of audience-input text to 8 (the default size
is 5) on that computer. This is useful for people with visual impairment or if the screen is being
projected for a group audience.

* /psize 8 (or another number): this changes the font size of player-input text, as above.
* /info: gives some information about UpStage.

Logged-in players have a lot more commands available to them - see the chapter on Commands for more
information.

Applause

p . <narrator> and they all lived
eople like to applause at the end of a show, so one of happily ever after!

the new features in UpStage v3 is an applause button for | _ - arrator> THE .E ND

the audience. Players can show or hide this button

according to when they want applause or not.

» /applause will make an applause button appear

in the Audience view, below the text input field. it was great]

* /noapplause will hide the button. —

Note that the button ONLY appears in the audience view; this means that logged-in players cannot
applaud (but you can of course play an audio file of applause from the audio palette).

Volunteer

An audience volunteer button is in development but not yet fully implemented. This will allow you to
expose a "volunteer" button that lets an audience member temporarily come on stage with an avatar.


http://en.flossmanuals.net/upstage-v242-user-manual/commands/

Logging In

Players log in to UpStage to create and present performances. You do not need anything other than a
browser with the Flash player plugin, and an internet-connected computer, to do this.

Log in

From the home page, click on Sign In at the top right of the screen:
Request an Account or Sign In

The enter your username and password in the input boxes that
appear (or, if you don't have an account, click the link). You can
tick Remember me? if you will be regularly accessing UpStage
from your computer.

Logln: irlend A Password: esssses
Remember me? [ ( Login )

Audience members dont need to log in to view peformances!
Dont have an account? Find out how to get involved.

Once you have logged in you will see the following information:

Welcome back, friend!

The numbers indicate how many players and audience in total are on iz

all of the stages on this UpStage server at the current time.
Currently on Stages
Registered Players : 0
Guest Audiences : 1

Player permissions

Depending on the permissions level that you have been given, once you have logged in you will have
access to different tools. There are currently four levels of permissions: player, maker, admin and creator.

* Player
The default "Player" permissions enable a logged in player to access the on-stage player tools, so
that they can collaborate in a performance. This level is also used for guest log-ins for open
walkthroughs and workshops where people are learning the basic operations of UpStage before
starting to make their own show. This default level does not give access to the Workshop.

*  Maker
A player with "Maker" permissions can access the Workshop to upload media, edit their own
media, create stages and edit their own stages; as well as access the on-stage player tools.
There is also "Unlimited Maker' - allowing a maker to upload files larger than IMB.

*  Admin
A player with "Admin" permissions can edit others media and stages as well as their own, add and
edit players, and edit the content of the Workshop pages. Unlimited upload permission.

*  Creator
A player with "Creator" access cando everything an admin can do, as well override a stage lock
and create new creator level users. Usually a creator will be the person or people who have set up
a particular UpStage instance, and therefore may also have access to the server in order to perform
upgrades and other maintenance.



Player Profile

All players with more than the default player level of access can edit their own profile, change their
password or add/update their email address.

From the Workshop navigation, click on Edit Players then edit the information you want to update.

Details for friend:

You've been with us since:
Your current contact emal s

Fogy, 18 October 2013 10:24AN NEDT
Unsel

Change Password:
New Pasyword:
Confem Password:

Save Password
Change emait

New emuad

Save Emae

UpStage V3.0 BETA (18/10/2013)




Player View

Players log in to UpStage to create and present performances. You do not need anything other than a
browser with the Flash player plugin, and an internet connected computer, to do this.

Different levels of access and permissions can be given to players. The default level allows access only to
the on-stage player tools, for collaborating in performances and learning how UpStage works (see the
chapter Logging In for more information about player permissions).

The "player view" of the stage is different to the "audience view" (see the chapter Audience View).

[ANANA] ey -
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The wardrobe (top right hand corner) is a scrollable list of the avatars that have been assigned to this
stage. The mirror (the square beside the wardrobe) shows the avatar you are currently holding (if you
are holding one), with its name in the rectangle under the mirror.

There are tools below the mirror, and image galleries for backdrops and props along the bottom of the
stage area. Players see a smaller text chat window than the audience.

The tools and palettes are explained in detail in the next chapters.


http://en.flossmanuals.net/upstage-v3-user-manual/audience-view/
http://en.flossmanuals.net/upstage-v3-user-manual/logging-in/

Avatar Tools

An avatar is a graphic object that a player operates to move around the stage and speak, a sort of digital
puppet. The avatar palette, at the top right of the player stage view, provides tools for holding and
moving an avatar.

Holding and moving an avatar

The avatars assigned to a stage appear as small named icons in the wardrobe (the area at the right of the
avatar palette); use the arrows to scroll up and down the wardrobe list. To hold a particular avatar, click
on its icon in the wardrobe. The icon will disappear from the wardrobe and appear in your mirror, the
square area to the left of the wardrobe. This shows you which avatar you are currently holding. A greyed-
out icon in your wardrobe means that another player is holding that avatar.

Once you have an avatar in your mirror, click on the stage area and your full-size avatar will appear there.
Click in another place, and it will move there.

Tool palette

The set of buttons below the mirror give you tools to operate your avatar. There are also the green arrows
in the mirror - these allow you to move your avatar in front of and behind other avatars on the stage.

Fast/Slow

This button controls the avatar movement — fast causing the
avatar to jump to where you click, and slow causing it to ‘ A k imaborag
glide there. The button shows the action that the avatar will a v g sultcase
change to when next clicked — for example if your avatar is =2 | =

gliding, the button will show fast. Click on it to change to

fast, and the button will become orange and say slow. hen

Stop - rame

When your avatar is gliding (in slow mode), click on stop to - drop = cloar

stop it at any point in its trajectory. (Budio] P01 | A0
| auchio )1 | A00

Name
This button will hide or show your avatar’s name on the stage — this is particularly useful when working
with invisible avatars. When you first hold an avatar, the default state is for the name to be showing, so
click on name before you place the avatar on the stage if you don’t want the name to show.

Draw
This button changes the function from acting to drawing, displaying the drawing tools palette instead of
the avatar tools. See the chapter Drawing Palette for more information about drawing.

Drop

The drop button will remove your avatar from the stage, and put it back in the Wardrobe so that you are
no longer holding it. If you want to leave your avatar on the stage while you operate another avatar,
simply select the new avatar from the Wardrobe without clicking drop.

Clear
Use clear to remove all unheld avatars and props from the stage.

Audio
This button displays the audio tools palette. See the chapter Audio Palette for more information about
using audio.



Player/Audience counter

Below the control buttons, a counter keeps a live tally of the number of players (P) and audience (A)
present on stage at any time. Typing /details in the text chat input field will give you a list of the
usernames of the players and the number of audience in the chat window.

Right-click menu

The right-click menu is accessed by right-clicking you
avatar on stage; if you are using a Mac, hold the
control key (ctrl) and click on the avatar to access the
menu.

Rotate Avatar Right
Rotate Avatar Left

Rotate Avatar Left/Right Move Up

These options allow you to rotate your avatar 90° ' Move Down

either clockwise (right) or anti-clockwise (left). Move Fast
Move Slow

Move Up/Down

(note - have asked for this to be changed to "Move
Forward/Backward" as that is clearer.)

These options change which "layer" your avatar is on,
allowing you to hide your avatar behind other objects Settings

(excluding the backdrop) or have it in front of Clobal Settings...

everything else. The same functionality is provided by About Adobe Flash Player 11.9.900.117...
the green arrows in the mirror.

Draw On Avatar
Clear Draw On Avatar

Rename Avatar

Move Fast/Slow

These control how your avatar moves about the stage. Fast will cause it to jump to where you click, and
slow make it glide to where you click. The same functionality is provided by the fast/slow button in the
tool palette.

Draw On Avatar

This allows you to draw on your avatar. Anything you draw on your avatar will move with your avatar.
When you select this, you will see that the tool palette changes to the drawing palette. Adjust the colours
and brush size, then draw onto your avatar.

Click the blue act button in the drawing palette then move your avatar around the stage, and you will see
that the drawing moves with the avatar.

Note that if you select a layer in the drawing panel and then draw, this will NOT be attached to your
avatar.

Clear Draw On Avatar
This will clear all drawings currently on your avatar.

Rename Avatar

This allows you to rename your avatar, and will only work if you right-click on the name.You can also
rename your avatar with the /nick command.

Operating Multi-frame or Animated Avatars

Avatars that have been created as .swf animations, or uploaded as multiframe avatars, allow you to
change the avatar while it is on stage.

If you have created your avatar as a .swf file, it will animate in the workshop, wardrobe and mirror. If it
has been uploaded as a series of pngs, only the first image will display in the mirror and wardrobe on



stage. In the workshop, the first image will display in the initial preview, and if you click the Preview
button you can play through the series of images.

Changing your avatar's frame
When placed on the stage, animated avatars will appear as a still image in the first frame of the animation.
Type /a 0 to start the looped animation, and to display a different still frame type /a 1 (the default), /a 2, /a

3 and so on.

To have the avatar appear with an image other than the first frame when it is first placed on the stage, type
the frame number (/a 2 or whatever number you want) before you put the avatar on stage.

Flash Movieclips will animate on loop without typed-in commands. You need to create these as movies in
Flash — see the chapter Creating Graphics for UpStage for more information.

Rename Your Avatar

There are three ways to change an avatar's name:
1. off stage, via the media edit section of the workshop,
2. on stage using either the command /nick

3. on stage using the right-click menu.

The on stage methods are explained here.

Type /nick newname (with newname being the new name that /nick bob|
you want) in the text input field at the bottom of the chat
window, and hit enter.

Or, place your cursor over the name of your avatar where it shows on the stage, right-click and select
Rename Avatar. You will then be able to edit the text on the stage. You will see the name underneath your
mirror change, and when the avatar is on stage the new name will appear below it (unless you have used
the name button to turn off the name). The new name will also appear in the text chat window before the
text your avatar speaks.

When using invisible avatars, you can make words float around the stage by showing the name, and
using /nick or the right-click menu option to change the visible word on screen.

Only about 9 characters will be visible on stage; if you have a longer name it will be visible in full in the
text chat, but not on the stage.



On-stage Player Tools

Logged-in players have access to a range of on-stage tools, not visible to the audience, which enable the
real-time manipulation of preloaded media and live elements on the stage.

The previous chapter showed the default player view of the stage, with the avatar palette at the top right
above the chat, and galleries for props and backdrops at the bottom of the screen. The avatar palette
appears as the default, with the audio and drawing palettes accessed by clicking the appropriate button in
the avatar palette. These three palettes are explained in the following chapters.

Changing Backdrops

Backdrops are images that fill the entire background area of the stage; avatars, props, streams and all
except one layer of drawing appear in front of the backdrop.

The backdrops assigned to a particular stage appear as small icons in the backdrops gallery, at the
bottom left of your screen.

Roll your cursor over the icons to display the name label so that you can accurately choose the backdrop
you want. If more than 8 backdrops are assigned to a stage, arrows will appear at either end of the bar to
allow you to scroll through the backdrops, which

are displayed alphabetically. rain

Click once on the icon to place the backdrop onto F m r,ﬁ i E
the stage; click the icon a second time to remove it.
Multiframe backdrops can be used in the same way as normal backdrops; to change the backdrop's frame,
type /b 1, /b 2 etc in the text input field. Type /b 0 to make the backdrop animate through its frames. (For
information about creating multiframe backdrops, see the chapter Creating Graphics for UpStage).

Holding and Placing Props

Props are images that can be "held" by an avatar; you must be holding an avatar on the stage in order for
that avatar to then hold a prop. When an avatar holding a prop moves, the prop will move with the avatar.

T - M0 [P

[~

The props assigned to a stage appear as small
icons in the props gallery at the centre bottom of
the screen.

L

When you roll your cursor over the icons, a name label appears, allowing you to distinguish between
similar or very small props. If more than 8 props are assigned to a stage, arrows will appear at either end
of the bar to allow you to scroll through the props, which are displayed alphabetically.

Click on the prop icon in the gallery, and it will appear at the top left of your avatar. Click again on the
prop icon in the gallery, and it will remove the prop from your avatar. If another player clicks on the same
prop that you are holding, it will be transferred to their avatar.

Props that have been created as .swf animations, or uploaded as multiframe props, do NOT allow you to
change the frame of the prop while it is on stage (unlike avatars and backdrops). When placed on the
stage, a prop which has been uploaded as an animated sequence will appear only as a looped animation; a
prop uploaded as a single frame (as .swf, .jpg or .png) will appear only as a still image. (For information
about creating props, see the chapter Creating Graphics for UpStage).



Audio Palette

Prerecorded MP3 audio files can be uploaded and assigned to a stage. This chapter deals with how audio
files are operated on a stage; see the chapter Uploading Media for information on how to upload audio
files.

Click on the yellow audio button in the tool palette to

o>
reveal the audio palette. Audio files assigned to the stage % g {hp:buso * ¥ applause

2lasl

will appear alphabetically in a list on the right, with 4R S *+ ﬂ nukleusl
musical notes indicating music tracks and a megaphone (5] storm

icon indicating sound effects. Use the green arrows to =l R »rel ﬂ super he
scroll up and down if there are more than six tracks W e o+

assigned to the stage. (S} my doorbeN ﬂ drumroll

. ) . . . . .‘E s | * d b
Click on a track in the list on the right, and its name will B e e | ﬂ my door
appear in one of the three slots to the left. Use the buttons

at the left to start, pause, loop and stop each track. -- ﬂ storm v

The horizontal sliders allow you to set start and stop points within the track, and the vertical slider at the
left provides separate volume control for each of the three tracks.

You can stop all tracks at the same time by clicking clear all.

Click on the blue act button to return to the avatar tool palette. (Your avatar can still speak and move
when you have the audio palette open).


http://en.flossmanuals.net/upstage-v3-user-manual/uploading-media

Drawing Palette

Clicking on the draw button in the tool palette reveals a different set of tools — the drawing palette. You
can be still holding an avatar while you are drawing and can speak, but you won’t be able to move your
avatar on stage, because your cursor is now your paintbrush. Click the act button to return to the tool

palette so that you can operate your avatar again.

Drawing layers

Drawing allows you to draw directly onto the stage, in one
of four layers; the layers correspond to the four boxes on the
right hand side of the drawing palette.

Click on the red pencil icon to select a layer to draw in.

The black border shows which layer you have selected; a
pale blue border indicates that another player is holding that
layer. In this example (left) you are holding the top layer,
which has the black border around it, and another player is
holding the layer beneath, which shows a pale blue border.
If you select a layer with a blue border, you will "steal" it
from the other player.
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The top box will draw in the top layer, over the top of any avatars. The next two layers let you draw in
amongst the avatar layers, and the bottom layer draws behind the backdrop (so when a backdrop is placed

on the stage, the drawing will be hidden).

Drawing tools

Click the eye icon to hide or show your drawing. Click clear to erase all the drawing from that layer.
Note that it is currently not possible to erase only part of the drawing in a layer.

The slider in the layer box controls the transparency of what has already been drawn in that layer: move
it to the left and the drawing in that layer will become more transparent; move it all the way to the left and
it will vanish completely. This is useful for fading a prepared drawing in and out, for example to create a

"curtain" effect that covers the whole stage then is faded out to indicate the start of a scene.

The colour picker at the top has three sliders, letting you
adjust the colour of what you’re about to draw. Move the
sliders to change the hue, and the new colour appears in
the square to the left of the sliders. The small squares
below the colour picker sliders show your last used
colours, which is useful is you what to repeat the same
colours in several drawings as you can simply click on the
small square to draw with that colour.

The slider immediately below the colour picker controls
the transparency of what you are ABOUT to draw, that is
you can draw in percentages of transparency on the same
layer (use the slider in the layer box to change the
transparency of something AFTER you have drawn it).

The circle and slider below the transparency slider control




the size of your brush. Move the slider to the right and the circle will increase in size, indicating how big
it will appear on stage. Move it to the left to make it smaller.

Currently it is not possible to erase, other than to clear everything in a particular layer. If you are trying to
draw a curved line and find that it appears as sections of straight lines, you are moving your mouse faster
than UpStage can keep up with; try drawing slowly for smoother curves.

If you want to draw a completely straight line, hold the shift key down while you click at the beginning
and the end of the line.

Attaching a drawing to your avatar

A new feature in UpStage v3 is the ability to attach a drawing to your avatar. This means that the drawing
will move with the avatar, so for example if you have drawn a hat for your avatar, it can stay on the
avatar's head when it moves to another place on the stage. Or, if you are using an invisible avatar, a
drawing can move around the stage by itself.

To create a drawing attached to an avatar, right-click on the avatar and select Draw on avatar. You can
then adjust the colour, transparency and size in the drawing palette.

Click the blue act button in the drawing palette then move your avatar around the stage, and you will see
that the drawing moves with the avatar.

Note that if you select a layer in the drawing panel and then draw, this will NOT be attached to your
avatar.

You can only draw on the avatar that you are holding. When you drop the avatar from the stage, the
drawing will also be removed.



Speech and Text Chat
I've got
Avatars are different to other visual media in UpStage (e.g. props and DORIOTINYS B0 Y
backdrops) because they have the power of speech. Using text2speech

synthesis, avatars' text can be spoken aloud in a variety of ways.
Note that at the moment, it is only possible to use characters from the

Roman alphabet (including letters with accents such as ¢, A, g, {i) but
not other alphabets such as Cyrillic, Greek, etc.

Speaking

To make your avatar speak, type into the text input field below the chat
window (bottom right of your screen) and hit enter (if there isn’t a
blinking cursor line there already, click the mouse there).

Your text will appear after your avatar’s name in the text chat window, as well as in a speech balloon on
the stage above or below your avatar (unless your avatar is not on the stage). It will be spoken aloud in
the voice selected for that avatar.

The audience can also type into the text chat, but their text isn't spoken out loud and only appears in the
text chat window, not on the stage. As the audience doesn’t log in, there are no names connected to the
audience chat. If you are logged in but not holding an avatar, your text appears the same as audience text.

Note that the default font size in the text chat window is 5. You can
i think therefore | am increase or decrease the size of the font on individual computers using
the commands /asize (audience text) and /psize (player text) followed
by a number, e.g. /asize 8 to make the audience text font size 8.

<dan=> this is how we speak in UpStage
<dan=> { and this is how we think }

Thinking <dan> AND THIS IS HOW WE SHOUT!

You can make your avatar "think" by typing : (a colon) before the
text. Your text will appear in a thought bubble over the avatar, but won't
be spoken aloud. It will appear in the text chat window in blue and with
curly brackets around it.

‘. LISTENUP
“, EVERYBODY! )

1 \ - -

Shouting

To make your avatar "shout", type ! (exclamation mark) before the text.
Your text will appear in a red-outlined bubble over the avatar, and in the
text chat window as red capitalised text. It will be spoken aloud and the
avatar's voice is subtly modified upwards in pitch.

Avatar Voices

UpStage uses the Festival Speech Synthesiser and MBROLA to generate
text2speech audio for the avatars' voices.

When you upload a new avatar, you can select a voice for it from the


http://tcts.fpms.ac.be/synthesis/mbrola.html
http://festvox.org/festival/

dropdown menu in the upload screen. To change the voice of an avatar that has previously been uploaded,
go to the edit screen for that avatar and select a new voice from the dropdown menu. In both situations,
you can test the voices to decide which one you want.

Once you have changed the voice, you will need to reset the stage(s) it is assigned to for the change to
take effect.

Note that changing an avatar's voice will change it on ALL stages that the avatar is assigned to; therefore
you should not change the voice of an avatar that is not yours, or that other people may be using on
another stage.

See the appendix on Text2Speech Voices for more information about available voices, descriptions, and
how to add more.

Saving the log

The text chat is automatically saved by the server, and can be viewed by adding "/log" to the end of the
URL in the address bar of your browser (e.g. http://upstage.org.nz:8084/stages/walkthrough/log). You can
then either select Save as from your browser’s file menu, or copy and paste the text into a text file.

To permanently delete all of the text from the chat log for a stage, go to the stage edit screen and click
Clear stage at the top-right of that screen. This will also remove any drawing, and clear any media left on
stage (putting it back into the wardrobe, not unassigning it).

Whispering

Players can "whisper" to other logged-in players; this lets you communicate with your fellow players
without the audience hearing or seeing it. You can whisper to an individual player, a number of players, or
to all logged in players present on the same stage as you. You can also whisper to players on other stages,
but you must use their usernames, and there is currently no way to whisper to a player who is in the
Workshop and has no stage open. Note that you can have multiple stages open at the same time in
different browser tabs or windows, and you can have the Workshop open as well as a stage or stages.

Typing a whisper command incorrectly displays a "how to" message in your chatwindow.If messages are
not delivered to users (due to misspelling a username, or a user not currently being online), the whisper
"bounces" and informs the sender what went wrong in the chat field.

Commands:

To whisper: Type:

to a single player /wh usernamel=message

to multiple players /wh usernamel,username2,username3=message
to all players on the same stage as you /wh *=message

Note - /whisper works exactly the same as /wh but obviously it's easier to just type /wh.


http://en.flossmanuals.net/upstage-v3-user-manual/text2speech-voices

/ Commands
<helen> i wonder where it came
There are a number of commands you can type into the text from

chat input field to do certain things. Typing a / at the ;
beginning tells UpStage that what is following is a 5
command, rather than text to be spoken.

Here is a list of the commands that can be used by players: /details]

/al,/a2etc displays a different frame of an animated or multiframe avatar

/a0 animates a multi-frame or animated avatar

/asize /asize followed by a number will adjust the size of the audience text

in your chat window (note — this only affects your own screen; the
text size will not adjust for the audience or other players); the default
size is 5. Audience can also use this command to adjust the size of
font in their browser

/b 1,/b2etc displays a different frame of a multi-frame backdrop

/b0 animates a multi-frame backdrop

/details lists the usernames of all players and the number of audience
members who are present on that particular stage

/help gives you a list of some of these commands

/info shows information about UpStage including which version of the
software you are using

/nick allows you to change the name of the avatar you are holding —
type /nick newname

/license provides information about the dual GPL and Creative Commons
license

/psize /psize followed by a number will adjust the size of the player text in

your chat window(note — this only affects your own screen, the text
size will not adjust for the audience or other players); the default size
is 5. Audience can also use this command to adjust the size of font in
their browser

/whisper or /wh allows you to communicate with other players without the audience
being aware; the whisper command is explained in the chapter
Speech and Text Chat

/applause Brings up a button below the chat box. This button is available to
everyone on the stage and plays an applause sound when clicked.

/noapplause Hides the applause button

/colour /colour followed by a hex code will change the colour of the text in

the chat box. (note - this only affects your own screen, the text
colour will not change for aduience members or other players)

: before your text will give you a silent thought bubble, rather than a
speech bubble and spoken text. The text is blue in the chat window

! typing ! before your text will make your avatar shout. The speech
bubble outline and the chat text is red




The Workshop Interface

Once you have logged in to UpStage, you arrive at the workshop, from where you can either proceed to a
stage to rehearse or perform, or choose from a range of options that allow you to create and manage
stages and players, and upload and manage the media (graphics and audio) that you will use in your
performances.
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At the top left, the UpStage logo provides a link to the UpStage web site, where you can find information
about the UpStage project, festivals, regular open sessions and other activities.

To the right of the logo, HOME will take you to the foyer page for this UpStage server: this is the public
entry point, where audience can find information about upcoming shows and click on links to enter
stages. The content of the Home or Foyer page can be edited by players with admin permissions.

WORKSHOP is the page you are on, and STAGES gives a list of all the stages on this server.

In the top right-hand corner, you can log out, and you can also see how many players and audience are
currently on this server.

At the very bottom of the screen is the version of UpStage and the date it was last updated.


http://upstage.org.nz/

Workshop Navigation

From the workshop links between the green and black lines, you can do the following:

Create/Edit Stage: create a new stage, or edit an existing one.

Upload Media: upload graphics and audio files, and in the same process assign them to stages and
select voices for avatars.

Edit/View Media: browse and view media (filtered by who has uploaded it, type of media, or
stage it is assigned to); edit your own media (including changing avatar voices); and assign or
unassign media to and from the stages.

Edit Players: edit your own password and email address and, if you have admin permissions, edit
the profiles of other players and create new players.

Those with admin permissions will see an additional link at the right-hand end of the navigation bar, Edit
Page Mode; this takes you to an interface to edit and customise the content of the workshop pages.

How to do all of these things is explained in more detail in the following chapters.

Messages for UpStage players

The text area below the navigation is an editable area (by users with admin permissions) that can be used
to provide information for players on this server - for example if maintenance is scheduled at a particular
time, or to remind people about upcoming events and deadlines.



Creating and Editing Players

All players can edit their own information; if you have admin permissions you can edit your own and
others' information, and create new players.

Edit your profile

From the Workshop navigation, click Edit Players.

Workshop: Create/Edit Stage Upload Media Edit/View Media

All players can update their email address or change their password. (note - check whether basic players
can do this; we want them to but i'm not sure if they can ...)

Details for friend:

You've been with us since: Frogy, 18 October 2013 10:24AN NZDT
Your current contact emad is Unseds

Change Password:
New Password:
Confem Password:

Save Password

Change emalk
New emal

Save Emae

UpStape VIO BETA (181002013

Administration links

If you have admin permissions, you will also have the ability to create new players, edit the details of
existing players, and delete players. You will find these Administration Links below the save buttons at
the end of your details.

Adding a player
To add a new player:
1. Click Create New Player and a dialogue box will pop up.
2. Enter a username and password for the new player (if you use a generic or easy password, you
should advise them to change their password when they first log in).
3. Enter their email address (if you don't have it, this can be added at a later date by you or the
player).
4. Select the permissions (explained below) that you wish to give this player.
5. Click Save Player.



Adding a player
Pk a username and password
Usermame:

Password:

Password agan:

1 oaad addrens:
Phyer permissions
& Player - Gt WCt on ages
Maker - G5 0T/ 28 SLages, LM 0L Med and Tas all Poat DerTEse
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Creator - can 20 averything
Save Playe

Player Permissions

Different permissions can be given to players, according to what you want them to be able to do and
access on your UpStage server.The default permissions allow access to the on-stage tools, but no access
to the Workshop to upload/edit media, or create/edit stages. Tick the checkboxes to give a player extra
permissions:

* Player: The default permissions enable a logged in player to access the on-stage player tools, so
that they can collaborate in a performance. This level is also used for guest log-ins, for open
walkthroughs and workshops where people are learning the basic operations of UpStage before
starting to make their own show. This default level does not give access to the workshop.

* Maker: A player with Maker permissions can access the workshop to upload media, edit their
own media, create stages and edit their own stages; as well as access the on-stage player tools.

* Unlimited Maker: A player with unlimited upload permission can upload files larger than the
1MB file upload limit.

* Admin: A player with admin access can administer their own and others media and stages,
add/edit players, and edit the Workshop pages. An admin user has unlimited upload permission.

* Creator: A player with creator access can do everything an admin can do, as well override a stage
lock and create new creator level users.

Editing Players

From time to time, you may need to edit the details of a player other than yourself - for example if
someone's email address has changed but they haven't updated it themselves, or if you wish to give
someone extra permissions such as an unlimited upload limit. The most common example is when a
player has forgotten their password - an admin player can create a new password for them so that they can
log back in.

The Edit Existing Player Details link at the bottom of an administrator's Edit Players screen will give a
list of all players, and clicking on a player will open their details at the right of the player list. Here you
can change a player's permissions, email address and password.



David X
Change Permissions
This player s &

Player - &0 act on stages

Maker - Cat Coate) 48 Saged, ORI/ mada ard Yas al Maye

PRITTENOA
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Change Emal

Change Password
Tk 20 change the use’'s passwonrd
New password:

New password again:

Make the changes that you want to make for the player, then scroll down to click [ = ’to save the
changes. ‘
This is also where you can delete a player, by clicking on ‘i - but be careful! This does not currently

have a warning pop-up that allows you to cancel the deletion.



Creating and Editing Stages

Stages are web pages on which UpStage performances take place. An UpStage server can have any
number of stages, and media uploaded to the server can be assigned to multiple stages.

A player can be "in" more than one stage at a time, simply by having different stages open in different
browser tabs.

Audiences enter a stage for a performance by clicking on the stage link - from the foyer page of your
UpStage server, from another web site, or from an email. In a similar manner, an audience member could
attend concurrent shows on different stages by using tabs or windows or a show that is presented in
multiple stages.

Workshop: (=10 S 145 =T ] Upload Media Edit/View Media Edit Players

Create a new stage

To create a new stage, clickCreate/Edit Stage in the Workshop menu, and then with the dropdown menu
showing New Stage, click Select.

Workshop: Create/Edit Stage Upload Media

Make a new stage, or select one to edit
~ New Stage _ﬂ ( Select )

A dialogue box will open over the page. Enter a name for your stage and the URL - this can be the same
as the name, but it can't have any spaces in it.

Full name: My New Stage Short name for url: newstage| no spaces).[ Create Stage

8 P:
Close

Click Create Stage and, voila! your stage has been created. You will find yourself at the edit screen for
your new stage.

Editing a stage

You will arrive at the edit screen when you create a new stage following the steps above. If you wish to
edit an existing stage, in the workshop menu click Create/Edit Stage and then select the stage you wish
to edit from the dropdown menu.
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You can edit the name of the stage, and its URL, by changing the text in the appropriate boxes then
clicking Save.

Splash message
The splash message appears on the screen while a stage is loading and as a welcome message on the chat

field; you can use this text to give some information about your show. After editing the text, scroll to the
bottom and click Save.

Splash message
Welcome to UpStage!This stage is for open walkthroughs - online
training sessions

Debug message

The option to print debug messages on the backdrop of your stage is primarily for developers, so that they
can identify bugs by seeing what is happening as actions are performed on the stage. However, it can and
has been used in performance, to add a layer of performing code to your show.



Stage list

This option allows you to hide your stage on the stage list. If it
is not selected then people will need a link to get onto the
stage (either as a player or an audience member).

Lock Stage

This option will allow you to lock a stage so it cannot be
modified by anyone other than yourself, or players who you
give access to (see below). Only a player with creator
permissions, or the owner of the stage, is able to unlock a
stage.

Background colour

Here you can select background colours for different areas of
your stage: the chat window, the tool palette, the props and
backdrops bars and the entire stage. Click on the radio button
for the area whose colour you wish to change, then select from
the colour palette. The chosen colour will be displayed in the
box under the name of the area.

Remember to click Save in order to save your changes.

Stage media controls

Debug message
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New to version 3.0 of UpStage is the ability to preview and unassign media from the edit stage screen,
which is very useful if you have uploaded a number of similar media items in order to test them on the
stage, and then want to remove the ones you don't want to use.

To preview a media item that is assigned to your stage, select it in the Assigned list and click Preview.
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To unassign a media item, select it in the Assigned list and use the green arrows to move it to the To be
unassigned list. Remember to click Save in order for this to take effect.

Unassigning does not delete media from the server, it just takes it off that stage. You will still find it in the
media management system and it will still be on any other stages it has been assigned to.



Player access

Another new feature in UpStage v3 is the ability to set different player access levels for a stage.
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When you first create a stage, all players apart from yourself will be listed in the Audience access only
section. You can choose which players you want to give player access to the stage, and which players can
also edit the stage, by selecting the player name and using the green arrows to move them to the
appropriate list. The creator of the stage will always have full edit access.

Note - players with creator status have full edit access for all stages.

Save buttons

There are a number of different possibilities for saving your stage:

* Save stage will save the changes you have
just made in the edit screen.
Save stage Save and reload stage

Clears the text chat and drawing
layers,

* Clear stage will delete all the text in the
chat window, remove any media that has
been left on the stage (it will still be Cancel Discard the changes you have made.
assigned to the stage, just not visible on the
stage area) and remove any drawings that
have been left in the drawing palette.

Clear stage

Delkete this stage (does not delete

Delete med@ that s assigned to this stage).

* Cancel will remove any changes you have entered in the screen, without saving them, so your
stage will not be changed.

* Delete stage will delete the stage completely (note that this does not delete from the server any
media that has been assigned to the stage).

» Save and reload stage will save the changes you have entered, and cause the stage to reload for
any players and audience who are currently on it. This is useful during rehearsals when you are
trying out different media and want people to see something you have just assigned to the stage,
but should be avoided during performances - unless you deliberately want the audience to
experience an unexpected stage reload.



Uploading Media
The following media formats can be uploaded to UpStage:

* audio: mp3 ONLY
» graphics: swf, png, jpg and gif. swf will give the best quality result, as all files are converted to
swf on upload. swf and png will allow for transparency.

Other formats of audio and video can be streamed to UpStage - see the chapter on Prerecorded streams
for information on how to do this.

You must first create your media in a graphics or audio application, before uploading; please see the
section on Creating Media for more information about this.

Note: the Upload Media page cannot be used on Internet Explorer 7 or below; we recommend using the
latest version of your browser to ensure compatibility. If you are unable to upload we recommend using

an alternative browser such as Firefox or Chrome.

How to upload media

Workshop: Create/Edit Stage QU LETRLELIER Edit/View Media Edit Players

Click Upload Media in the workshop navigation bar, and you will see the following screen:

From the dropdown menu, select the type of media you want to upload (Avatar, Prop, etc.). The screen
will expand to provide the upload form.

Workshop: Create/Edit Stage Upload Media [dit/View Media Edit Players

What type of media are you adding?

Choome & name and upload the Mie(s)

For udic ume el Then
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UpStage 3.0 BETA (25/10/2013)
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We will look at each media type in detail.
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Upload an avatar

When you select Avatar from the dropdown menu, the screen will expand to give you the form below:

What type of media are you adding ?
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Enter a name and any tags you want to attach to this media item (tags can help you to find a media item
later) then click Browse to navigate to where your media item is on your hard drive or online.

Avatar voice

Select a voice for your avatar from the dropdown menu of voices. To hear what each voice sounds like,
click Test Voice (you can change the text that will be spoken in the input box). There is more information
about the different voices in the appendix Text2speech Voices.

Streaming Avatars

A stream avatar enables an audio-visual stream to be displayed on the stage. See the section on
Streaming for information about how to do this.

Multi-frame avatars

One way to create animated or multi-frame avatars is to use an application such as Flash that can generate
a multi-framed swf file. Another option is to create multi-frame avatars in the upload process.You will
need to prepare each frame beforehand, making sure that each image is the same size, then upload them
using the number of frames dropdown menu.

1. Select the number of frames you require (up to 10), which will create additional fields below

Filename 1: for each frame.
2. Click Browse to navigate to the file that you have created for each frame of the avatar.

Assign to a stage
You can assign your avatar to any of the existing stages as part of the upload process:

1. Click on the name of the stage in the Unassigned list to select it.
2. Click on the arrows to move it to the Assigned list.


http://en.flossmanuals.net/upstage-v3-user-manual/streaming
http://en.flossmanuals.net/upstage-v3-user-manual/text2speech-voices

Upload!

When you're ready, click Add Media to upload your media. If you've forgotten to enter any required
information - such as a name - a dialogue box will prompt you. You can change the information later.
Upload a backdrop

Backdrops work in the same way as avatars; select Backdrop from the dropdown menu and the form is
the same as for avatars, but without the voice and streaming options.

Upload a prop

To upload a prop, select Prop from the dropdown menu and you will see a similar form to that for
uploading a backdrop, minus the multiple frame option.

Updoad 3 Prop: Assign o a Stage
e iwne ) ot
A Neda Roue ®
Upload an audio file

Select Audio from the dropdown menu, navigate to find your file, and select any stages that you wish to
assign the audio to. The only difference this time is that you are also asked to select either Sound Effect
or Music as the type of audio file.

Audio files MUST be MP3 format.
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Browse Media

One of the major improvements in UpStage v3 is the greatly enhanced ability to filter and browse media
that has been uploaded to the server. You can use filtering, tags and search in order to find what you want
quickly and easily.

Workshop: Create/Edit Stage Upload Media Edit Players

Clicking Edit/View Media in the Workshop navigation bar gives you an interface where you can browse
all of the media that has been uploaded, by yourself and other players, as well as edit individual media
items (see the chapter Edit Media for information on editing).

The default view will show you media uploaded by you, and provides information about each media item
including:

* who uploaded it and when

* what type of media it is, including stream information
* any stages the item is assigned to

* an avatar's voice

* any tags given to the item.

TR/ View Modia
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At the bottom of the table is the total of the file sizes for the items displayed; this is useful if you have a
lot of media on your stage and are concerned about loading times - use the filters as described below to
display all the media on a particular stage and it will give you the total weight of that stage.

Filter your displayed media

Usually you will be most interested in finding your own media (which displays as the default) or media
uploaded by your collaborators for a particular show. The filtering system allows you to do that easily.


http://en.flossmanuals.net/upstage-v3-user-manual/edit-media

Just select the options you want for each of the categories:

* User: displays all the media uploaded by a particular user (player)

» Stage: displays all the media items assigned to a particular stage

* Type: displays all the media of a particular type (i.e. avatars, backdrops, audio or props)

* Medium: this currently does not work; it will allow you to filter within the Types by stream,
video, sound effect and music

* Tags: displays all the media which has a particular tag assigned to it.

Search

You can also search for a piece of media via the search box. The search box works with the filter (so if
you have the filter set to avatars that were uploaded by yourself, then the search will only find avatars you
uploaded which meet the search term).

The search will check the name, stream-name and tags of each piece of media and show the items which
have a match to your search term. The searching is not case sensitive and will find partial matches (i.e.
searching for ‘test’ would show items called ‘testing’ as well as items called test).

Tags

Another way to search for specific media items or groups of media items is to use tags. Tags can be added
at the time of upload, or later by editing a media item (see the chapter Edit Media for information on how
to do this).

Tags can also be used to:

» group media that is intended for workshops and tutorials, such as informative backdrops and
example media items

* make media on a specific theme findable by other players

* help manage a large amount of media if you are a heavy UpStage user.


http://en.flossmanuals.net/upstage-v242-user-manual/edit-media

Edit Media

To edit media that has been previously uploaded, click Edit/View Media in the Workshop navigation bar.

Workshop: Create/Edit Stage Upload Media B 0JAYCVALEL(EY Edit Players

Use the filters, tags or search box (explained in the chapter Browse Media) to find the media item(s) you
want to edit.

From the table view, click on the line of a media item to

display its preview and editing tools. The information thatis | <% & 27 D ¥,
displayed in the table will appear under the preview, along
with the item's URL on the server and the size of the file. Jubias

The eye icon gives a full size preview of the avatar (playable
if it is animated).

The pencil icon is where you can change the name and voice
(note that this will change it on ALL stages where the media
item has been assigned, so use with caution).

The circle of two arrows icon is to replace the media item
with a new file - very useful if you are testing avatars on the

stage and don't want to end up with many similar ones. Type: satar
Fle: Jmdia/ aaNcIW . ot
The chain link icon lets you assign the media item to stages, Sos 795298

Delte: 29201 9 2003 AN
Urer: ademn
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or unassign it.
The tag icon gives the option to add or remove tags.

The downwards arrow icon lets you download the item. P

The trashcan icon is delete - you will get a popup window
that lets you cancel if you have clicked this by mistake.

The edit interface is the same for all types of media, apart from one difference: avatars have the voice
dropdown menu and Test Voice button, and audio items have a Test Audio button, which allows you to
listen to the file.
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Creating Graphics for UpStage

Avatars, backdrops and props for UpStage can be created using standard graphics applications such as
Gimp, Photoshop, Fireworks, Flash etc. However, before you go ahead and upload something you
prepared earlier, please read this chapter as there are many important points to ensure that your graphics
appear the way you want them once uploaded to UpStage.

Format and size

The recommended formats for your original graphics files are .swf or .png.Vector-based images will
appear much cleaner than pixel images (such as .gif and .jpeg), as they resize in UpStage to match the
dimensions of individual screens and browsers. You can use .gif and .jpg but your images will lose quality
(note — as the exception to the rule, backdrops are fine as jpegs).

Backdrops will fill the stage area, no matter what size the original file is. See the section below for
information about creating backdrops.

Avatars and props will appear close to their actual size and in correct proportion to each other. Because
everyone who is watching the performance can have a different sized screen, resolution and different
browser window size, UpStage scales everything proportionally. Avatars and props will be smaller or
larger on different screens but they should always have the same proportions within UpStage and in
relation to each other.

Creating .pngs

The .png file format is good for avatars and props, as it allows for transparency (unlike .gif or .jpg) and
gives a good quality image. Most graphics applications will allow you to save your files as .png. In the
File menu of your graphics application, choose Save As and look for the .png option.

Do NOT interlace the file when you save it.

Creating .swfs

All graphic files that are uploaded to UpStage are converted to .swf format in the upload process. Because
of this, the best quality of graphics can be achieved if your original is already an .swf.

To create .swf files, you need an application which produces the .swf format. The following information
is based on the commercial Adobe Flash application, however there are now many open source
alternatives such as swfmill, SWFTools, Haxe, Flex, Red5 and FlashDevelop. If you have experience in
using any of these applications and would like to provide instructions for creating .swf graphics for
UpStage that could be added to this manual, please email info@upstage.org.nz.

Please note that the following information is by no means a comprehensive Flash tutorial. If you do not
know how to use Flash at all, or if the following steps are not clear to you, we recommend that you look
on the web for a Flash tutorial.

At the time of writing, UpStage only supports Actionscript 2; please make sure that you save your files
correctly, as files saved with Actionscript 3 will not work.


http://www.flashdevelop.org/
http://www.red5.org/
http://www.adobe.com/products/flex.html
http://haxe.org/
http://www.swftools.org/
http://swfmill.org/

Create a single frame .swf avatar or prop
The basic steps for producing a single frame avatar or prop using Flash is as follows:

1. Start with a .png file in which you have clear-cut your image and given it a transparent
background. Keep the .png image at a large size — around 500px square for a standard-sized avatar
is a good guide, as much larger will result in an unnecessarily large .swf file but a smaller file will
start to lose quality.

2. Open Flash and from the File menu, choose Import; navigate to your .png file and import it into

Flash.

Click on the image to select it — a grey border appears around it.

In the Insert menu, choose Convert to symbol — the border will change to a thin blue line.

5. Resize it (Modify > Transform) to the size that you want (you may need to upload a test to

UpStage to check the size, then make adjustments).

Once you have reduced it to the required size, adjust the document size to match.

7. From the File menu, choose Export Image. Put the jpeg quality up to 100% and save the .swf file.
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Animated avatars and backdrops
UpStage supports both animated sequences and Flash movie clips.

You can create an animated sequence either in Flash (an .swf with a series of frames) or by creating a
series of .pngs (or .jpgs or .gifs) and uploading them with the multiframe option in UpStage. When you
put sequenced (frame-by-frame, or motion or shape tweened) animation onto the stage it will appear static
with the image in the first frame. To change to other frames of the animation, type /a 2, /a 3, etc. To make
the avatar animate, type /a 0 and to return to the first frame type /a 1.

If you have saved your .swf as a movie clip animation it does not need any commands, it will
automatically loop and can be used on stage either as a continuously looping animation or as a series of
still avatars that are swapped using the /a command, as above.

Props and backdrops can also be animated using Flash. But bear in mind that Flash animations can end up
as larger files, which will increase the time it takes to load your stage.

Animated sequence
To create an animated sequence, follow these steps:

1. Create a series of .png files and give them numbered filenames.

2. Open Flash and from the File menu, choose Import and navigate to the first .png file; Flash will
ask if you want to import the series, say "yes". This will create a frame for each image.

3. On each frame in turn, click on the image to select it (a border appears around it); from the Insert
menu, choose Convert to symbol (the border will change to a thin blue line)

4. Resize (Modify > Transform) to the desired size.

5. Once the images are all reduced to the required size, adjust the document size to match; if your
images are not all exactly the same size make sure you have made the document size as big as the
largest image.

6. From the first frame, and with the image selected (the blue line should appear around it), go to the
Insert menu and select Create motion tween.

7. To check that the tweening has happened, go to the Control menu and select play — your sequence
of images should play.

8. From the File menu, choose Export Movie; put the jpeg quality up to 100% and save the file.



Sounds can be embedded into Flash movie clips, but it takes a bit of trickery to be able to control the
sound in UpStage.

When using Flash to create animated avatars and props, be sure to check the the frame rate and whether it
is set up to loop.If the frame rate is, for example, 24 fps and it is set to loop, the image will reload 24
times a second, regardless whether anything else is changing on the screen. Making your still flash
pictures run at, for example, 1 fps and/or switching off looping will ease the load on everyone’s browser.
Very slow animation, for example tweened over 40 or so frames and looping, will cause the least strain
and can create some very effective movement.

UpStage doesn't cope with movie clips nested within the frames of a Flash animation, but it is possible to
import Quicktime movies into Flash and then export as a .swf. You will need to experiment with file sizes
and perhaps remove some of the frames from the Quicktime movie in order to keep the file size down.
Once again, this manual does not pretend to provide a comprehensive Flash tutorial. Please look on the
web for more detailed information on using Flash.

Backdrops

(does this need updating?)

As long as the original image is 380x240px or larger, a backdrop will fill the UpStage screen, including
going behind the text chat window. You may wish to create a backdrop that has a blank area on the right
where the text chat window is to ensure that important parts of your backdrop are not hidden behind the
chat window.

The proportions of the whole image are:

total width : total height - 800 : 500 (or multiples of these proportions)

width of stage area : width of chat area - 5 : 3.5 (if your image is 800 wide, the chat will begin at 550).

minimum width : height — 380 : 240 pixels

/ : 3
Stage area Chat

eg. height = 500px area
width = 800 px

(of which 560px for stage and
240 px for chat background)

6.25

Bear in mind that everyone’s screen size and browser window size can be different — your backdrop will
stretch to fill the space.

Note that in the player view of the stage, an strip along the bottom of the backdrop will be obscured by
the backdrop and prop galleries — but these tools are not seen by the audience, so it is recommended that
your backdrop extend below that strip as the audience will see it.



TIP: it's a good idea to look at your stage in audience view as well as player view; you can do this while
you're working by having it open in two browsers, one where you are logged in and one not.

Backdrops can be created as .png, .swf, .gif or .jpeg; as with avatars and props, .png or .swf will give the
best quality results, however generally a .jpg backdrop will also be fine. If you are using .gif or .jpeg,
upload a test backdrop to see if it’s going to be good enough, and remember to delete unwanted images.

Note that .png files should NOT be interlaced when saving.

File Sizes

UpStage has a default file size limit of IMB for each media item uploaded. This is to encourage you to
make your files as small as possible, in order to minimise stage loading times. The larger the files you
upload, and the more media assigned to your stage, the slower the stage will load.

What is a "reasonable" file size for your original graphic? This is very hard to say, as it’s completely
different for a small static flat graphic prop which may be only 1K, and an animated flash backdrop or
multiframe avatar, which could be over 500K. And a stage with a single large graphic may load faster
than one with many medium sized graphics.

If your original files are larger than 500K, check whether you can resize them and save them again to a
smaller file size. Remember that screen resolution is only 72ppi so there is no need for your originals to
be at a higher resolution.

If you really need to upload something that is larger than 1MB, you can ask an admin to give you
unlimited upload permissions. Admins have unlimited upload permissions.

Deleting Graphics

It is good practice to delete unwanted graphics in order to keep the server tidy and minimise digital
storage requirements.

1. From Edit/View Media, browse to find the item you wish to delete and select it; its preview and
edit tools will appear at the right.

2. Click on the trash can icon.

3. A dialogue box will open, and if the media item is assigned to any stages it will show which
stages, and ask you to tick a check box to confirm that you want to delete the item from all of
these stages. If you're still sure you want to delete it, tick the box.

4. Click Delete to delete the item, or Cancel if you realise you don't want to delete it.

If you are working on a server that is used by many players, such as the Open UpStage
(http://upstage.org.nz:8084) please do not delete anything that has been uploaded by someone else. But
also be aware that we operate a Creative Commons policy, so your media may be "borrowed" by others,
for learning and playing; no-one should use someone else's media in a performance without the original
creator's permission.



Embedding links in graphics

Active hyperlinks can be created by typing a URL into the text chat window (use right-click or ctrl+click
to open or copy the link); however sometimes it’s useful to have a graphic onstage that provides a
hyperlink to another stage or a different web site.

The way to do this is to create a .swf image with an ActionScript button containing the following code:

on (release) {

getURL("http://desired.url", " self");

}

This could be an avatar or a prop that is placed on the stage at the time that you want the audience to
follow the link.

More Flash tricks

If you are experienced in using Flash and Actionscript, you can do a lot more with it in UpStage; most
(but not all!) interactivity that can be achieved in a web page using Flash, can be achieved in UpStage.
Performances that have enhanced audience interactivity through sophisticated Flash programming include
Virtual Theatre's Lines (090909 Festival) and Murder 2.0 (101010 Festival), and The Best Air-Guitar
Album in the World Vol Il by Anaesthesia Associates (070707 Festival).

The purpose of this manual is not to teach you how to use Flash, but there are some relevant tutorials on
the UpStage web site which you may find helpful.



http://upstage.org.nz/blog/?page_id=2556

Creating Audio for UpStage

As well as sound created in real-time by avatar voices or streaming audio, prerecorded .mp3 files can be
uploaded to UpStage and played via the audio palette in the on-stage player tools.

Prerecorded audio can include music, sound effects, human voices, etc. At this stage, only the .mp3
format works for uploaded audio files. Two other possibilities for adding audio to your performance are to
embed audio in a Flash animation, if you have the skills and ability to do this, or to FTP an audio file to a
streaming server and stream it into UpStage.

There is a 1MB file size limit for all media uploads, to ensure that the server doesn't get unnecessarily
filled up with enormous files and that stage load times are not too long and tedious for the audience.It is
possible to over-ride the IMB limit by giving a player unlimited upload permission, but remember that
when the audience enters your stage, all of the media assigned to the stage must be loaded to their
computer, therefore the bigger the files, the longer the load time.

Converting audio files to .mp3

There are many ways to create, convert and compress .mp3 audio files; we recommend that you refer to
other manuals for more information on this if you are not familiar with it.

If you are a Mac user, a simple method to convert an audio file from another format to .mp3 is to open the
file in iTunes, and from the Advanced menu sclect Create MP3 Version.



Introduction to streaming

UpStage v3 incorporates audio-visual streaming, which was developed for UpStage by Martin Eisenbarth

as part of the project We have a situation! during 2013.

Streaming via UpStage involves two things:

1. sending a stream from your computer to a streaming server; and

2. inserting that stream into the UpStage interface, by either creating a stream avatar or uploading
an .swf graphic (backdrop, avatar or prop) that has the stream embedded within it. The first option
is more straightforward, the second requires some knowledge of Flash and may slow down the
stage - so it is not recommended; but it is technically possible and may be appropriate in some

situations.

This chapter gives instructions on how to stream to a Red5 server, and how to create and use a stream
avatar. Some information on embedding a stream in an .swf graphic is provided but this manual is not

about how to use Flash.

11 stream

6‘ 7 helen

= ™ julius

a stream

po mad stre
) .-

B oo cew schaum s

suio | P04 | ADL

behind (important phonecall)
<apd stream> ok eva

<schaum stream> so | put url
<schaum stream> what else? as
I am sl not here..

<apo stream=> name: schaum
<apo stream> click connect
<apo stream>> then click start
<schaum stream> were put the
stream name?

<apo stream> big green button
<apo streams stream name
goes below url

<schaum stream: sorry, it says,
it has problem with the aucio
<schaum stream:> and then |
can only close window

<apa stream> HEADPHONES
<apo stream> HEADPHONES

&

Video tutorial

Here is a 10-minute video tutorial which gives examples of how streaming has been used in UpStage and

explains how to send a stream using the FMLE: https://vimeo.com/69239857

Note that this video is based on the video-hack version of UpStage, which is a fork from version 2.4.2, so
not all of the workshop interface is the same as in version 3. However the basic steps for setting up a

stream and creating and operating a stream avatar are the same.


https://vimeo.com/69239857
http://www.wehaveasituation.net/

Sending a stream
You need access to a streaming server to send an audio-visual stream from your computer to UpStage.

Note: this chapter is not about how to install a streaming server; for information on this please click here.
Normally you will not need to install your own streaming server, just have access to an existing one such
as a commercial service, one provided by a university or other institution, or a private streaming server.
UpStage has a streaming server; if you would like to use this, please contact info@upstage.org.nz.

The information in this manual is based on the Red5 streaming server; this is not the only option, but it is
the one that we have tested and found to work well.
Stream server name

The Red5 server will have an rtmp URL that will look something like this (with "example.com" being
the URL of the host server):

rtmp://red5.example.com/oflaDemo
or:

rtmp://example.com/oflabDemo
You will need to enter this into the Stream server field when you create your stream avatar in UpStage
(see the chapter Creating a stream avatar), and you will also need to enter it into the streaming
application that you use to send the stream from your computer.
Streaming client or publisher interface

There are two ways to send a stream from your computer to a Red5 server:

1. Using the Red5 Publisher - a browser interface provided by the RedS5 server.
2. Using a streaming client, such as VLC (Linux) or Flash Media Live Encoder (Mac & Windows).

Using a streaming client rather than the Red5 publisher gives more control over the quality and other
variables of your stream. It also allows you to save the settings in a profile, so that when you reopen the
client to restart a stream, your settings are automatically loaded and you do not have to enter them again.

Whichever option you use, you will need to:

enter the server URL (rtmp:// ...)

enter a stream name, exactly the same as it is for the UpStage avatar
select the appropriate video and audio devices

create a connection to the server

start your stream.

M

It is easy to make small errors in any of these steps that will stop your stream from working. For example,
a space at the end of the server URL will prevent the connection from being made. If your stream does
not work, carefully check all of these settings to be sure you don't have extraneous spaces or small typos.

This manual provides configuration instructions for the Red5 Publisher interface (no download required),
VLC and the Flash Media Live Encoder(FMLE). For the latter two, you will need to first download and
install the application; then follow the instructions in this manual.



https://www.adobe.com/products/flash-media-encoder.html
https://videolan.org/vlc/
https://www.adobe.com/products/flash-media-encoder.html
https://videolan.org/vlc/
http://www.red5.org/
https://github.com/foobarlab/UpStage/blob/development/STREAMING.txt

Red5 Publisher interface

The RedS5 Publisher is a browser interface that allows you to publish a stream without having to download
and install a streaming application. However, it does not allow as much control or optimisation over the
stream you are sending, so if you are going to be regularly streaming and/or wish to have the best quality
stream, it is recommended that you use VLC, FMLE or another similar application (see the following
chapters for download links and set-up).
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To access the Red5 Publisher, you need the publisher URL for the RedS5 server you are using. This URL
will look something like:

http://example.com:5080/demos/publisher.html

or

http: red5.example.com/demos/publisher.html

(where "example.com" is the url of the host server).

Enter the settings
Open the Red5 Publisher URL in a browser then follow these steps:

1. In the Settings area, select the Server tab and enter

the appropriate rtmp URL (in Location), then click — Bervr ! NESUR Ay
Connect: Serves | igcalhost oflalemo v | Connect
2. You should see now in the Log that you are Location  Fimgi/ [redS.axampie.com/oflaDems
connected, from the line that says
" 1 " [ 00N AMTO v Moy Nore v
NetConnection.Connect.Success" - don't worry
about the error messages. oo [ eds oy, RO o .

2 Dhoose your server ang press Conmec:


http://apo33.info:5080/demos/publisher.html
http://apo33.info:5080/demos/publisher.html

" Log

12:42:18:292 - Using Adobe Madntosh Flash Player 11,7,700,16%
12:50:50:931 - Connectng to rtmp:/ /redS.exampie.com/oflaDemo
12:50:51:576 - Asynchronous code enror - Referencetrror: Error #1069
12:50:51:626 - NetConnection.Connect. Success

12:50:51:712 - Asynchronous code error - Referencefrror: Error 21069
12:50:52:950 - Asynchronous code error - Referencetrrar: Error 21069
12:50:52:126 < Asynchronous code enror - ArgumentError: Error #1063

3. Go to the Video settings and choose the video source you want to use, then click Start.
4. Click Allow on the pop-up window that asks you if Flash can access your web cam.
5. Go to the Audio settings and choose the audio source that you want to use, then click Start

6. You should see in the Log that both your video and audio has started (naming could be different
depending on your hardware).

7. You should also see your webcam image and hear your audio in the preview tab. Now enter the
stream name (exactly the same as you have given to the stream avatar in the UpStage workshop,
this example shows the name 'mystream') and click Publish.

Note: the Publish tab only shows the capture from your hardware; to see the actual stream select
the View tab, enter the stream name and click Play.

8. If your stream is successfully published you will see it in the Log (you will also see error
messages, but these can be ignored):

" Log

12123108589 - Using Adobe Windoss Flash Mayes 11,656,602, 180
121222583450 - Connacting o rimpl/ /redS example com /ofa Demo
12:23:21:450 + Aaynchronous code error - Referencelrror: Brvor #1069
121231110484 « NatCornadtinnn. Cormadl. Suttess

12:22:128:33 Agynchranous code emor « Refersocelorer: Frrer 01069
12:123:21:855 ~ Aaynchronous code error - Referercelrror: Brmer #1069
12123125900 - Asynihronous (ode e - AspumentBrrer. Brvar #1080

12122: 26063 -« Started video devics Cameras Plus (VA Resolution Maximem )
12:126:09.0%0 « L2arted audio devee Mikrofon (Realtek Migh Defintion Audo)
13605090 - Saned sudin fevie Nibeoles (Resliak High Defintties Avde)
[13129133:30¢ - Publar - NetStream. Publeh.Stact |

9. To stop the stream, click Stop in the Publish tab.



Flash Media Live Encoder (Mac & Windows)

First download and install the cost-free Flash Media Live Encoder application (FMLE); you will need to
create an Adobe account if you do not already have one, but this does not cost anything. Then select
whether you want to download the Mac or Windows version. The current latest version at the time of
writing this manual is version 3.2, and that is what the version that the following instructions are for.

Stream settings

Once you have downloaded and installed the FMLE, open the application and enter the following settings
in the Encoding Options panel:

1. On the right hand side, under Panel Options: Output, ensure the box Stream to Flash Media
Server is checked.

2. Enter the appropriate stream server URL and stream name.

3. Click Connect to test the connection to the server.

Video and audio settings

The video and audio settings will vary according to your hardware, the quality of stream you want to
send, and the capability of the streaming server you are using. The following settings are what we are
using as standard for UpStage, but you can experiment with them.

1. Select your web cam and audio input from the dropdown menus; note - if you do not want to
stream audio, uncheck the box beside Audio.

2. The formats will normally be VP6 for video and MP3 for audio.

3. The video frame rate can be set at 30; if you have a lot of streams or a low capacity streaming
server, you can reduce the frame rate to improve performance.

4. Select the appropriate input size for your video; for best results, ensure that the Output Size
exactly matches the input size.

5. Bitrate: a low bit rate will help to ease the load on the server and reduce lag (delay) for those


http://www.adobe.com/de/products/flash-media-encoder.html

receiving the stream. We recommend 100 for video.
6. Click the green Start button to start streaming. Click the red Stop button to stop streaming.

Save a profile
If you are going to be using the same streaming server on a regular basis, remember to save a profile once
you have entered the settings by going to File > Save Profile. This means that next time you open the

FMLE, your settings will automatically be loaded.

If you try different settings to experiment with quality, you can save a new profile and then go back to the
original settings by going to File > Open Profile.



VLC (for Linux users)

VLC offers the possibility to stream on Linux using video4linux (can access different kinds of hardware
like webcams but also TV tuners etc.) and FFmpeg for transcoding (transcoding to FLV and sending
RTMP to a stream server).

The file STREAMING.txt contains some links to in-depth information about streaming parameters for
use with VLC.

Sample script

For easy setup please use the avstream_vlc_linux_example.sh script (download here by right clicking and
saving as file).

Modify settings
Adjust to your hardware:
* VIDEO_CAPTURE DEVICE:

e.g. /dev/video0 for your internal webcam, or /dev/videol and so on for further external
hardware

* AUDIO_CAPTURE DEVICE SLAVE:

use alsa://hw:0, 0 for your internal microphone or alsa://hw:1, 0 and so on for external
microphones

* set the stream url STREAM PUBLISH_URL, for example if your stream name is streaml:
rtmp://red5.example.com/oflaDemo/streaml
Additionally you may want to adjust all settings starting with STREAM ..., all other
settings probably won't need to be touched. The standard configuration is to stream with
VP6 and MP3 codecs, 320 x 240 pixels at 30 fps and a total bandwidth of 196 kBit/s.
Start streaming
Please ensure the script is executable and can be run:
* using the terminal: execute chmod 755 ./avstream vlc linux example.sh
* using a graphical windowmanager: right-click the file and select Properties, then search for the
settings to allow execution of the script by the user

If your script is executable you can run it:

* in the terminal: execute . /avstream vlc linux example.sh
* using a graphical windowmanager: double-click the script and select execute in terminal

Note: In case you want to see a live preview of the streamed video you can uncomment the line in the
section “watch stream?” of the script. You will need the software rtmpdump and mplayer.


http://www.mplayerhq.hu/
http://rtmpdump.mplayerhq.hu/
https://raw.github.com/foobarlab/UpStage/development/avstream_vlc_linux_example.sh
https://raw.github.com/foobarlab/UpStage/development/avstream_vlc_linux_example.sh
https://github.com/foobarlab/UpStage/blob/development/avstream_vlc_linux_example.sh
https://github.com/foobarlab/UpStage/blob/development/STREAMING.txt
http://linuxtv.org/v4lwiki/
http://www.videolan.org/vlc/

Creating a stream avatar

The easiest way to make your stream appear on an UpStage stage is to create a stream avatar. This avatar
is created in the same way as a normal avatar, from the Add Media section of the Workshop interface:

1. Click Add Media.

2. Select Avatar from the media type
dropdown menu.

3. Give the avatar a name, tags, and
select a voice if you want.

4. Check the "Enable streaming?' box. | veke -nses - (51 Thequck boown fox jumps over the lazy o [ Teat voice

. In the "Stream server' ficld, enter the | raue smesmng? o

rtmp address of the streaming server

Oroose media type: | Avatar

Upload an Avatar:

Nerre Tags

W

. . Stream server U0 [ (enample core ) oM aDemo
you will be using. s i g - —
6. In the "Stream name" field, give the
Sweam tyoe Auto-detect 191 | Test stream
stream a name.
7. Assign the avatar to the appropriate Uphoad your own image(s) @ Use bultn image

stage(s).
8. Click Add Media.
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You must have the exact same stream server and stream name information entered in whichever
streaming application you use. Click Test stream to see the stream, and then you can be sure you have
entered things correctly.

Stream as part of a graphic avatar

It is possible to have an avatar that is both a static or animated graphic AND a stream. To do this, once
you have entered the stream information as described above:

Select the radio button Upload your own image(s).
Select the appropriate number of frames.

Browse to the image(s) on your hard drive and select.
Assign the avatar to the appropriate stage(s).

Click Add Media.

MRS

Note that this means the stream will be visible behind every frame of the avatar, unless you are not
actually streaming anything.

Now go to your stage and start your stream in order to see your stream avatar; remember that you must
assign the avatar to a stage before you can see it!



Streams on Stage

, o () stream
Once you have set up your streaming application and }A
created your stream avatar, you can now assign the __" 0 bubbybo
stream avatar to a stage and start working with the e
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And when you hold it, it will appear in your Mirror like this:

Placing your stream on the stage

A stream avatar works the same way as other avatars - click on it in the wardrobe to hold it, it will then
display in your mirror, and you can click anywhere on the stage to place it there. Click elsewhere on the
stage to move it, and use the fast/slow, stop and drop buttons (or the right-click menu) the same as a
normal avatar.

When you first place the avatar on the stage, it will take a second or two for the image to appear.

Muting your audio stream

Hearing unwanted audio on stage can be very annoying and easily creates echoes and feedback. It's also
irritating to hear your own audio stream. If you only want to send a video stream without audio, you
should mute the stream at source - in the streaming application or Red5 Publisher. This will also save on
bandwidth.

However often you will want to send an audio
stream but not hear it yourself, or to sometimes
send video only and at other times send audio.
This can be achieved through the right-click
avatar menu.

Toggle Mute/Unmute Locally
The icons (9 and (X 0) el you whether your - :
stream is muted, or audible, for the audience.

Musical notes alone means that everyone can o . Move Fast
hear your audio stream, while the X before the v Siow
musical notes indicates that it is muted for Draw On Avatar
Clear Draw On Avatar
everyone.
Rename Avatar
Settings...
Clobal Settings...

About Adobe Flash Player 11.9.900.117...




Streams with images

P bubbybo:
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audio | P:01 | A:00 Changing the size of a stream

The size of your stream is determined by the size that you set in the streaming application (FMLE, VLC,
Red5 Publisher, etc). In order to change it, you need to stop the stream, set it to the new size and start the
stream again.

If you do this while the stream avatar is on stage, the image will disappear then reappear at the new size.
If you don't want the audience to see this, you can adjust the size while the stream is not on the stage.

Operating a stream from another player

Any player can hold and operate a stream avatar, it does not have to be the same player who is sending
the stream. This can free up the person sending the stream to appear in front of the camera without having
to simultaneously operate the avatar. Simply hold and operate it the same way you would an ordinary
avatar.



Prerecorded streams

It is possible to play a prerecorded video or audio file in the same way as a live stream. This allows you to
add additional media to the stage without increasing the initial load time for the audience, and enables a
greater variety of formats.

In particular, it allows the playing of prerecorded video at high quality, which was not previously possible
to do directly in UpStage (prerecorded video could only be played by embedding it in .swf files).

File formats that can be streamed are MP3, FLV, or for higher quality MP4 or AAC (note that higher
quality also means more bandwidth and potential problems for people on slower networks).

You will need FTP access to a streaming server; ask the person who is administering the streaming server
you are using for this information.

Streaming prerecorded video and audio

1. Via FTP, upload your video or audio file to the streaming server (note: use only letters and digits
in the file name, no special characters or spaces).

2. In UpStage, go to Add Media and create a stream avatar with the RTMP URL of the streaming

server and the stream name as the filename of the video or audio file.

Test the stream in the Add Media interface to ensure it is working.

Assign the stream avatar to the appropriate stage(s).

5. Go to the stage, hold the avatar, and place it on the stage; the recording will start playing from the
beginning of the file.

6. To stop the stream, simply drop or clear the stream avatar from the stage.

P w

Recommended bitrates

The bitrate of your streams are very important: the total bitrate of all the streams on stage at one time
should not exceed 800kBit/s, to avoid network overload and stream interruptions for some people.

For videos: a bitrate of 200 - 400 kBit/s should be sufficient.
For audio: a bitrate of 64 - 160 kBit/s should be sufficient.

(need info here on how to find out what the bitrate is)



Glossary

Here are definitions for some of the terms that are used in this manual. Please let us knowif something is
missing.

Audience: people present online at a performance, but not logged in. The audience can participate via the text chat, but do not
have access to the same tools as the players.

Avatar: a graphical icon that can be held and moved around the stage by a player, and that can speak.

Backdrop: a graphic which fills the stage behind any avatars and props that are placed on it. A backdrop can also extend
behind the text chat.

Chatters: the online audience are also referred to as "chatters", as they contribute to the performance via a text chat function.

Cyberformance: live online performance where remote players and/or audience use internet technologies to come together in

real time.http://en.wikipedia.org/wiki/Cyberformance

Drawing: functionality that allows real time drawing directly onto the stage.

Foyer: the home page of an UpStage server — where the audience can come to see what's on, and where players can log in.
Mirror: the square on a stage that shows a player which avatar they are currently holding.

Palette: e.g. "drawing palette" or "audio palette" — a set of tools for a particular function.

Player: a logged-in participant in a performance. Players have access to on-stage tools which allow them to manipulate
avatars, backdrops and props, and can have different levels of permissions to allow them to access the Workshop and
administration tools.

Prop: a graphic which can be held by an avatar or placed on the stage using an invisible avatar.

Splash screen: a sort of "curtain" that appears over the stage while it loads; the splash screen shows the name of the stage, a
loading progress indicator and an editable welcome message.

Stage: a dynamic web page where you can place and move avatars, props and backdrops to create a performance.

Stage tools: tools visible on the stage to logged-in players (but not visible to the audience) that enable the players to
manipulate media on the stage in real time.

Text chat: an input field and text chat window, where avatars’ speech and audience text appears and is visible to everyone; the
text chat window can be scrolled up and down to read text that has been entered previously, and can be accessed for saving by
adding /log to the end of the stage url.

Tools: the buttons, sliders and icons that allow logged-in players to manipulate media.

UpStage: UpStage is an open source platform for cyberformance: remote performers combine images, animations, audio, web
cams, text and drawing in real-time for an online audience. Players and audience need only a standard web browser with the
Flash player plug-in. For more information about the UpStage, visit the web site: www.upstage.org.nz.

Wardrobe: the interface through which players can select avatars on a stage; an alphabeticised and scrollable list of the icons
and names of the avatars assigned to that particular stage.

Whispering: silent text communication between logged-in players that is not visible to the audience.

Workshop: the "back stage" interface where logged-in players can upload media, view and edit existing media, create and
manage stages and manage players.


http://www.upstage.org.nz/
http://en.wikipedia.org/wiki/Cyberformance
mailto:info@upstage.org.nz

Text2Speech Voices

UpStage's speech is generated by the Festival Speech Synthesiser, developed at the Centre for Speech
Technology Research at Edinburgh University (http://www.cstr.ed.ac.uk/projects/festival/).

An avatar's voice is selected from a dropdown menu when uploading or editing an avatar. There are
currently about 100 voices on the Open UpStage server; if you are setting up your own UpStage server,
please see the technical documentation regarding installing voices.

Note that at the moment, it is only possible to use characters from the Roman alphabet (including letters
with accents such as ¢, i, @, 1) in the text chat, but not other alphabets such as Cyrillic, Greek, etc.

Voices currently available on UpStage

The voices currently available with UpStage have a filenaming system that gives a clue as to what kind of
voice each one is. Some of the voices speak English with a foreign accent, some speak English with
different English accents, and some are designed to speak other languages more-or-less accurately. We
have endeavoured to include a good variety of accents as well as male and female voices.

The format is: ["e" or "emb"] _[native language] - [en] - [modifications]

For example:

* ¢ _de — speaks and reads German

* ¢ _en — speaks and reads English

* ¢ en-fast-fl — speaks English quickly, in a female voice
* ¢ _en-wm — speaks english in a west midland accent.

Other accents in the e _en series are "n" for north, "sc" for Scots, "rp" for RP, "r" forrhotic (which means it
pronounces the r in words like church).

* emb_afl — speaks and reads Afrikaans
* emb_afl-en — speaks English in an Afrikaans accent
* emb de4-en-low-slow — speaks english, lowly and slowly, in a german accent

You can test the voices on the avatar upload and edit screens, by selecting different voices from the drop
down menu and entering the text you want to test.

We are in the process of compiling descriptions for all the voices; following is the information so far:

needs updating as not all voices are still available

Non-
Voice Male Female Accent Eng Description
bud X NZ? Deep, calm
crunchy Crunchy - good for witches & effects
default X NZ? Smooth, young
e_en-fast-fl X NZzZ? fast, boyish
e _en-r-f3 X NZ? fast, boyish
e en-wm-slow X Australian? nasal drawl
e_en-wm-slow-{3 X Australian? boyish nasal drawl, computerish & like a



https://sourceforge.net/apps/trac/upstage/wiki/documentation
http://upstage.org.nz:8084/
http://www.cstr.ed.ac.uk/projects/festival/

learner-reader reading

e eo X foreign
emb de4 X German German neutral German male
mid-range, clean, English w/German
emb_ded-en X German accent
emb_de4-en-low- pimp's voice: low & lecherous (English
slow X German w/German accent)
emb_de5 X German German slow low somewhat distorted voice
slow high somewhat distorted voice,
emb_deS-en X German English w/German accent
emb_de5-en-high- mid-high slightly strangulated male,
slow X German English w/German accent
middle somewhat slow and drawn out
emb_de7 X German German male, German
emb_enl-high X English soft mid-range male voice
emb frl-en-low X European low & lecherous
emb_fr4-en-high- mid-high male voice, sounds like he has
slow X European trouble speaking
low soft female voice with slight
emb_hul-en-slow European? European accent
emb nl2 X Dutch | 'mid-low male
mid-low male voice with slight European
emb nl2-en X European? accent
emb pll Polish? mid-low calm female
mid-low calm female with European
emb_pll-en Polish? accent
emb rol-en X
emb_swl-en-fast X Swedish? mid-low male speaking quickly
high X Computer boyish computer monotone
roger X English Thin, proper-sounding, not deep
slow X computer gets slower & lower, very good for effects




Adding more voices
You can install additional speech plug-ins on your own server to extend the range of voices available to
the avatars. As long as you don't mind messing around with the source code a little bit it's not difficult —
Patricia Jung explains how she did it (for Linux, using UpStage V1 - note that this is now several years
old):

Just add another entry in the VOICES section in Upstage/upstage/voices.py like:

#txt2pho/mbrola:

'del": (""| /usr/local/mbrola/pipefilt | /ust/local/mbrola/preproc /usr/local/mbrola/Hadifix.abk
/ust/local/mbrola/Rules.Ist | /usr/local/mbrola/txt2pho -p /usr/local/mbrola/data/
|/usr/local/mbrola/mbrola /usr/local/mbrola/del/del - -",

_fest),

I know, it looks awful but this is only because the command is an awful chain consisting of four
commands with a couple of options each and the relevant path:
"| pipefilt ...| preproc ... | txt2pho ... | mbrola ..."

It does some preprocessing (like exchanging all appearances of "z.B." with "zum Beispiel"),
then hands the resulting text over to txt2pho and to mbrola.

As long as your command or command chain takes text input from the standard input and
outputs the result as sound in raw format on the standard output chain (Unix stuff, ask me if you
haven't heard about it) you can put whatever you like in between the "| and the ".

The above mentioned awful command chain will work when one has installed the txt2pho
frontend; it uses the del female mbrola voice, and you can choose it in the web interface using
the name del.

The only problem with this kind of reconfiguration is: as config.py isn't a nice configuration file
but a python script one needs to know at least that python is very picky about vertical alignment:
It's extremely important that your new voice entries have the same amount of whitespaces at the
beginning of the line as the other voice entries.

The reason it took me so long was TTS: I failed completely and utterly in making the German
festival extensions for use with mbrola voices:

http://www.ims.uni-stuttgart.de/phonetik/synthesis/festival opensource.html

work. Then I tried txt2pho with mbrola:

http://www.ikp.uni-bonn.de/dt/forsch/phonetik/hadifix/ HADIFIXforMBROLA .html

(http://bogmog.sourceforge.net/document_show.php3?doc_id=34 has a nice installation
description), ignoring Festival, and this worked at once.
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Troubleshooting

UpStage is a work in progress: it is being maintained and developed by volunteer programmers, which
means that things happen but sometimes slowly, and sometimes things break as we go. We welcome input
from anyone who has the time and skills to work with us on the development of UpStage - please visit the
GitHub site for more information, and join the developer's list.

If you encounter a problem that isn't listed here, or that you still can't find an answer to, please:

* check theFAQ page on the UpStage web site, maybe there's an answer there;

* visit the Issue list on GitHub to see if it's something that we're working on (if it is, please add
comments as more information can help to find a solution);

» contact the UpStage team- we will try to help.

Browser Problems

We are constantly monitoring browser compatibility, so if you experience problems connected to your
choice of browser, please contact us.

If you are having browser problems, we recommend the following:

 ensure that you have at least version of the Flash player installed,
* close your browser window, open a new window and log in again. If you still have problems after
doing this, quit your browser application and restart it.

Note: due to an issue in Internet Explorer 7 and below, you will not be able to use the media edit or media
upload pages. For this reason we recommend the use of either alternative browser (such as Firefox or
Chrome) or update to Internet Explorer 8 or above.

Fonts look bad

If an .swf file has been saved as low quality (in the original file), it can force the whole stage to appear
"low quality". This can be changed by right-clicking (on a Mac, ctrl+click) on the stage, and selecting
Quality from the menu that appears. If Low is selected, change it to High and you will see that the fonts
now display properly.

However, this will only correct the problem on your machine; your audience may not know how to
change the quality. A better solution is to work out which image is causing the problem, delete it and
resave the original file as high quality.

Linux Fonts

If you are using UpStage on Linux you may find that fonts are not appearing on stage. This problem is
fixed by installing additional packages:

* apt-get install gsfonts gsfonts-x11
¢ and http://www.macromedia.com/shockwave/download/download.cgi?
P1_Prod Version=ShockwaveFlash&P2 Platform=Linux&P3_Browser Version=Netscape4

untar/gzip
* close all browsers, run the installer (see installation instructions on the url above).
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